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BX Series Communications Error 

 

BX Series Communications Error

TEC 3-4 / 3-5 series and TEC B-472 / B-572 series

●     Make sure the printer cable is plugged into the printer and the computer correctly. 
●     Install new cable if this does not fix the problem. 
●     If this does not fix the problem, contact distributor for service. 
●     Check DIP Switch settings. 
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Excessive Head Temperature 

 

BX Series Excessive Head Temperature

TEC 3-4 / 3-5 series and TEC B-472 / B-572 series

●     Turn the printer off. 
●     Check software and hardware heat settings. 
●     Let print head cool down for 30 minutes and try again. 
●     If this does not fix the problem, contact distributor for service. 
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BX Series Head Error 

 

BX Series Head Error

TEC 3-4 / 3-5 series and TEC B-472 / B-572 series

●     There is a problem with the print head. 
●     The print head should be replaced. 
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BX Series Head Open 

 

BX Series Head Open

TEC 3-4 / 3-5 series and TEC B-472 / B-572 series

●     Open the print head and examine the head-up switch, which is located immediately to the left of the print head bracket (as 
viewed from the front of the machine). 

●     The switch has a small metal tab on it that pushes up against the switch itself when the print head is closed. 
❍     Is the metal tab still present? 
❍     If it is, gently push on it with your finger (toward the wall of the printer). 

●     Does the printer go on line? If it does, your switch is still good. 
❍     To correct the problem, very carefully bend the lower part of the metal tab toward the right, then close the print head. If 

the printer goes on line, then you are good to go.
●     If the printer continues to give a 'head open' error or if the metal tab is missing from the switch, then the printer needs to be 

repaired. 
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BX Series Label Tracking Problems 

 

BX Series Label Tracking Problems

TEC 3-4 / 3-5 series and TEC B-472 / B-572 series

Incorrect label tracking is generally the result of poor alignment of the labels themselves. This problem can occur for a 
number of reasons: 

●     Failure to center a roll of labels on the supply holder. 
❍     Printers with self-centering media supply holders usually do not present a problem here, unless the supply 

spindle has been damaged in some way. 
❍     Otherwise, on printers without the self-centering guides, make sure that the labels are centered on the spindle.

●     Sliding of the label roll on the supply holder. 
❍     This problem generally comes up if the external supply holder pieces are broken, missing, or installed too 

loosely.
●     Improper alignment of the media guides or failure to use them. 
●     Improper positioning of the pinch roller. 
●     Excessive wear or accumulations of ribbon or label residue on the feed roller and/or the platen roller. 

Some of these problems are not easy to fix on site. If you are having label tracking problems, call SATO Labeling solution's 
Technical Support Department for assistance. 
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BX Series No Paper Error 

 

BX Series No Paper Errors

TEC 3-4 / 3-5 series and TEC B-472 / B-572 series

●     The media has run out. 
❍     Check to make sure the media is loaded.

●     The media is not loaded properly. 
❍     Make sure the media is under the print head block.

●     The sensor is not aligned with the media properly. 
❍     Be sure the sensor is in the correct position. 
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BX Series No Ribbon Errors 

 

BX Series No Ribbon Errors

TEC 3-4 / 3-5 series and TEC B-472 / B-572 series

●     On the back side of the print block, the ribbon must pass between the two parts of the ribbon sensor. 
❍     The upper sensor is located on the back of the print block itself, while the lower sensor is located on the black plastic 

arm that extends from the main printer wall. 

 
Temporary Fix for No Ribbon Error 

●     Turn off printer. 
●     Hold the FEED and PAUSE keys while turning the printer back on. 
●     Press the FEED key until PARAMETER SET shows in the display. 
●     Press the PAUSE key until RIBBON TRANS shows in the display. 
●     Press the FEED key until RIBBON NO TRANS shows in the display. 
●     Press the PAUSE key until PARAMETER SET shows in the display. 
●     Turn the printer off and then back on to bring it to ONLINE condition. 
●     ***THIS IS A TEMPORARY FIX*** 
●     Printer should be sent to SATO Labeling Solutions for permanent repair ASAP. 
●     Piece of dark tape over ribbon sensor eye. 
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BX Series Paper Jam 

 

BX Series Paper Jams

TEC 3-4 / 3-5 series and TEC B-472 / B-572 series

●     The media may be jammed in the printer. 
❍     Make sure the label path is free of debris and lables.

 
●     The wrong media sensor may be selected in the software. 

❍     Make sure the correct sensor type is selected according to the media type.
 

●     The sensor may not be properly aligned with the media. 
❍     Make sure the labels are not shifting. 
❍     Make sure the sensor is properly aligned with the media.

 
●     The media may not be calibrated properly to the sensor. 

❍     Make sure the printer is calibrated to the correct media type.
 

●     Be sure the correct label size has been entered in the software. 
❍     Make sure the vertical gap is set according to media type.
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BX series RAM Clear 

 

BX Series RAM Clear

TEC 3-4 / 3-5 series and TEC B-472 / B-572 series

●     Turn the printer off. 
●     Press and hold the PAUSE and FEED keys and turn the printer on. Should show "DIAG" in the display. 
●     Press the RESTART key until RAM Clear shows in the display. 
●     Press the PAUSE key until NO RAM Clear shows in the display. 
●     Press the RESTART key until PARAMETER CLEAR shows in the display. 
●     Press the PAUSE key. Should show astericks and then show complete in the display. 

If complaint is fixed, reset the TONE ADJUST(T) back to +4 in ADJUST SET. 
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BX Series Ribbon Error 

 

SX Series Ribbon Error

TEC 3-4 / 3-5 series and TEC B-472 / B-572 series

●     TEC printers require the use of ribbon that loads 'coated side out'. 
❍     Make certain that your ribbon is loaded correctly. 

●     Check for excess foil on the take up roll. 
❍     Remove excess foil if necessary.

●     Set "Ribbon Adj (BAK)" to a lower setting. 
❍     Set to -5 or lower

●     Check your software settings and make sure that the print type is 'thermal transfer'. 
❍     If your software package requires the use of a Windows driver, also make sure that the driver is set for thermal transfer 

printing. 
●     Check to see if there is any dirt on the ribbon spindle gears or on the ribbon motors. 

❍     For the latter you will need to remove the electronics cover. 
●     If there is dirt in either of these areas, try vacuuming around the motors and/or the spindles to remove as much of the dirt as 

possible. 

[IMPORTANT: Make sure your printer is turned OFF when you vacuum the motors. Keep away from the main logic board.] 
 

Tech. Support main page         

http://localhost/BX/bxre.htm6/20/2007 2:14:14 PM



BX Series Sensor Calibration 

 

BX Series Sensor Calibration

TEC 3-4 / 3-5 series and TEC B-472 / B-572 series

●     Turn the printer off. 
●     Hold the FEED and PAUSE key and turn printer on. 

❍     Should display DIAGNOSTIC in display.
●     Press the FEED key until (4) SENSOR ADJUSTMENT shows on the display. 
●     Press the PAUSE key until TRANSMISSIVE shows in the display.
●     What kind of material is being used?

❍     If calibrating for adhesive labels place the backing paper without any labels on it under the sensor.
❍     If calibrating for plastic tags remove all materials from under the sensor.

●     Press and hold the RESTART key until an asterisk shows to the right of the digits.
❍     Should read in 4.0 volt range.

●     Press the PAUSE key until (4) SENSOR ADJUSTMENT shows in the display.
●     Turn the printer off.
●     Turn the printer back on to return to online status.
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BX Series SG Errors 

 

BX Series SG and other graphics errors

TEC 3-4 / 3-5 series and TEC B-472 / B-572 series

The SG error indicates that the printer has received incorrect graphical information. Sometimes this error is the result of a label 
formatting problem. Hence, the first thing to check is the label format itself to make sure that there are no problems with the graphics 
(including True Type fonts) that may be used as part of the design. 

Before doing anything else, check all the graphics fields on your label design (icluding all True Type fonts) to make sure there is 
nothing wrong with them (e.g., they are extending off the edge of the label design). If everything looks OK, then we will probably 
need to look elsewhere for a solution. 
 
Known Causes of SG errors: 

●     Incorrect settings in printer driver. 
❍     Change driver settings per these illustrations... 
❍     If your driver does not have these adjustments you should install another printer driver. 

●     Bad printer cable and/or switch boxes. 
❍     Replace printer cable 
❍     Disconnect switch boxes

●     Incorrect Taggit Pro Configuration settings. 
❍     Change these settings ... 
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BX Series Test Print 

 

BX Series Test Print

TEC 3-4 / 3-5 series and TEC B-472 / B-572 series

●     Turn printer off. 
●     Hold FEED and PAUSE keys and turn the printer on. 

❍     Should show DIAGNOSTIC in display.
●     Press the FEED key until TEST PRINT shows in the display. 
●     Press the PAUSE key. 

❍     Display should show PRINT CONDITION.
●     Press the PAUSE key. 

❍     Display should show ISSUE COUNT.
●     Press the RESTART or FEED key to set the desired number of test prints. 
●     Press the PAUSE key until LABEL LEN shows in the display. 
●     Press the FEED or RESTART key until the correct label length has been reached. 
●     Press the PAUSE key until PAPER FEED shows in the display. 
●     Press the FEED key until PAPER NO FEED shows in the display. 
●     Press the PAUSE key. 

❍     Display should show (3)TEST PRINT.
●     Press the PAUSE key until PRINT CONDITION shows in the display. 
●     Press the FEED key until SLANT LINE(3DOT) shows in the diplay. 
●     Press the PAUSE key. Labels should print out with test pattern printed on them. 

❍     To repeat the print out, press the PAUSE key until labels print again.
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BX Series Threshold Calibration 

 

BX Series Threshold Calibration

TEC 3-4 / 3-5 series and TEC B-472 / B-572 series

●     Make sure pre-printed labels are installed in printer. 
●     Press the PAUSE key once. 
●     Press and hold the PAUSE for more than 3 seconds and when 2 labels have been issued. 

❍     NOTE: On some models, pressing the pause key will change the LCD display to 'TRANSMISSIVE'. If this happens, 
repeat this step. 

❍     When both conditions have been met, release the PAUSE key. 
●     Press the RESTART key to return to online condition. 
●     Threshold setting is complete. 
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SX Series Communications Error 

 

SX Series Comm Errors

TEC SX-4 and SX-5 series

●     Make sure the printer cable is plugged into the printer and the computer correctly. 
●     Install new cable if this does not fix the problem. 
●     If this does not fix the problem, contact distributor for service. 
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SX Series Excessive Head Temperature 

 

SX Series Excessive Head Temperature

TEC SX-4 and SX-5 series

●     Turn the printer off. 
●     Check software and hardware heat settings. 
●     Let print head cool down for 30 minutes and try again. 
●     If this does not fix the problem, contact distributor for service. 
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SX Gap Sensor Placement 

 

SX Series Gap Sensor Placement

TEC SX-4 and SX-5 series
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SX Series Head Error 

 

SX Series Head Error

TEC SX-4 and SX-5 series

●     There is a problem with the print head. 
●     The print head should be replaced. 
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SX Series Head Open 

 

SX Series Head Open

TEC SX-4 and SX-5 series

●     The print head block is opened in the online mode. 
●     Feeding or printing has been attempted with the print head block open. 

❍     Close the print head block and press restart.
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SX Series Label Tracking 

 

SX Series Label Tracking

TEC SX-4 and SX-5 series

Incorrect label tracking is generally the result of poor alignment of the labels themselves. This problem can occur for a number of 
reasons: 

●     Failure to center a roll of labels on the supply holder. 
❍     Printers with self-centering media supply holders usually do not present a problem here, unless the supply spindle has 

been damaged in some way. 
❍     Otherwise, on printers without the self-centering guides, make sure that the labels are centered on the spindle.

●     Sliding of the label roll on the supply holder. 
❍     This problem generally comes up if the external supply holder pieces are broken, missing, or installed too loosely.

●     Improper alignment of the media guides or failure to use them. 
●     Improper positioning of the pinch roller. 
●     Excessive wear or accumulations of ribbon or label residue on the feed roller and/or the platen roller. 

Some of these problems are not easy to fix on site. If you are having label tracking problems, call SATO Labeling solution's Technical 
Support Department for assistance.  
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SX Series No Paper Error 

 

SX Series No Paper Error

TEC SX-4 and SX-5 series

●     The media has run out. 
❍     Check to make sure the media is loaded.

●     The media is not loaded properly. 
❍     Make sure the media is under the print head block.

●     The sensor is not aligned with the media properly. 
❍     Be sure the sensor is in the correct position. 
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SX Series No Ribbon Error 

 

SX Series No Ribbon Error

TEC SX-4 and SX-5 series

●     The ribbon should be routed from the feed spindle, then down through the center of the print block, underneath the print head, 
and up to the take-up spindle. 
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SX Series Paper Jams 

 

SX Series Paper Jams

TEC SX-4 and SX-5 series

●     The media may be jammed in the printer. 
❍     Make sure the label path is free of debris and lables.

 
●     The wrong media sensor may be selected in the software. 

❍     Make sure the correct sensor type is selected according to the media type.
 

●     The sensor may not be properly aligned with the media. 
❍     Make sure the labels are not shifting. 
❍     Make sure the sensor is properly aligned with the media.

 
●     The media may not be calibrated properly to the sensor. 

❍     Make sure the printer is calibrated to the correct media type.
 

●     Be sure the correct label size has been entered in the software. 
❍     Make sure the vertical gap is set according to media type. (0.120 for adhesive labels and 0.000 for plastic labels)
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SX Series RAM Clear 

 

SX Series RAM Clear

TEC SX-4 and SX-5 series

●     Turn the printer off. 
●     Press and hold the FEED and PAUSE keys and turn the printer on. Should show "DIAG" in the display. 
●     Press the RESTART key until RAM Clear shows in the display. 
●     Press the PAUSE key once. NO RAM should show in the diplay. 
●     Press the RESTART key. PARAMETER CLEAR should show in the display. 
●     Press the PAUSE key. QP type should show in the display. 
●     Press the RESTART key until QQ type shows in the display. 
●     Press the PAUSE key. Display should show astericks and then show complete. 
●     Turn the printer off. 
●     Turn the printer on. Display should show ONLINE. 

If complaint is fixed, reset the TONE ADJUST(T) back to +4 in ADJUST SET.  
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Resetting RFID Module 

 

Resetting RFID Module

TEC SX-4 and SX-5 series

 
Start with the printer turned off. 

1.  Hold down the FEED and PAUSE keys while powering up the printer. The LCD will read ‘<1> DIAG VX.x’ 
2.  Press the RESTART key once. This will bring you to the RFID menu. 
3.  Press the PAUSE key twice. The default LCD setting here is ‘MODULE NONE’. 
4.  Press the RESTART key twice to select the U1 module. [U1 indicates the version of the RFID module employed on US 

printers.] 
5.  Hit the PAUSE key to save the change. You will now see the TAG menu. 
6.  On the tag menu, press the RESTART key to select the type of RFID tag that you will be using (such as EPC1). 
7.  Press the PAUSE key to save the change. 

OPTIONAL: Press the PAUSE key until you come to POWER LEVEL [available on some models]. It is recommended that a 
moderate power level be used for best results, although the appropriate level may depend on the tag selected. The middle range is 
around 120-140. Use the FEED or RESTART keys to increase or decrease the value.  
 
NOTE: The U1 module does not become active until after the printer is turned off and powered up normally.  
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SX Series Ribbon Error 

 

SX Series Ribbon Error

TEC SX-4 and SX-5 series

●     TEC printers require the use of ribbon that loads 'coated side out'. 
❍     Make certain that your ribbon is loaded correctly. 

●     Check for excess foil on the take up roll. 
❍     Remove excess foil if necessary.

●     Set "Ribbon Adj (BAK)" to a lower setting. 
❍     Set to -5 or lower

●     Check your software settings and make sure that the print type is 'thermal transfer'. 
❍     If your software package requires the use of a Windows driver, also make sure that the driver is set for thermal transfer 

printing. 
●     Check to see if there is any dirt on the ribbon spindle gears or on the ribbon motors. 

❍     For the latter you will need to remove the electronics cover. 
●     If there is dirt in either of these areas, try vacuuming around the motors and/or the spindles to remove as much of the dirt as 

possible. 

[IMPORTANT: Make sure your printer is turned OFF when you vacuum the motors. Keep away from the main logic board.] 
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SX Series Sensor Calibration 

 

SX Series Sensor Calibration

TEC SX-4 and SX-5 series

●     Turn printer off. 
●     Press and hold the FEED and PAUSE keys and turn the printer on. 
●     Press the FEED key until (5)SENSOR ADJ. shows in display. 
●     Press the PAUSE key until REFLECT shows in the display. 
●     Place plastic labels under sensor. (SEE NOTE) 
●     Press and hold the RESTART key until asterick shows to the right of the digits. 

❍     Should read in the 4.0 ± 0.3 volt range. 
❍     Remove plastic labels from printer.

●     Place backing paper from adhesive labels under the sensor. 
●     Press the PAUSE key until TRANS. shows in the display. 
●     Press and hold the RESTART key until asterick shows to the right of the digits. 

❍     Should read in the 4.0 ± 0.3 volt range. 
❍     Remove adhesive backing paper from printer.

●     Press the PAUSE key until RIBBON shows in the display. 
●     Press and hold the RESTART key until asterick shows to the right of digits. 

❍     Should read in the 0.7 range.
●     Press the PAUSE key one time. 
●     Turn the printer off. 
●     Turn the printer on to bring back online. 

NOTE: If colored labels are being used, calibrate to the darkest color being used. Usually red.  
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SX Series Graphics Errors 

 

SX Series Graphics Errors

TEC SX-4 and SX-5 series

The SG error indicates that the printer has received incorrect graphical information. Sometimes this error is the result of a label 
formatting problem. Hence, the first thing to check is the label format itself to make sure that there are no problems with the graphics 
(including True Type fonts) that may be used as part of the design. 

Before doing anything else, check all the graphics fields on your label design (icluding all True Type fonts) to make sure there is 
nothing wrong with them (e.g., they are extending off the edge of the label design). If everything looks OK, then we will probably 
need to look elsewhere for a solution. 
 
Known Causes of SG errors: 

●     Incorrect settings in printer driver. 
❍     Change driver settings per these illustrations... 
❍     If your driver does not have these adjustments you should install another printer driver. 

●     Bad printer cable and/or switch boxes. 
❍     Replace printer cable 
❍     Disconnect switch boxes

●     Incorrect Taggit Pro Configuration settings. 
❍     Change these settings ... 
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SX Series Test Print 

 

SX Series Test Print

TEC SX-4 and SX-5 series

●     Turn the printer off. 
●     Hold the FEED and PAUSE buttons while turning the printer on. 

❍     DIAG. should show in display.
●     Press the FEED key until TEST PRINT shows in the display. 
●     Press the PAUSE key. Display should show PRINT CONDITION. 
●     Press the PAUSE key. Display should show ISSUE COUNT. 

❍     Press the RESTART or FEED key until desired count shows in the display.(Ususally 3 or 5)
●     Press PAUSE until SENSOR shows in the display. 

❍     If media is adhesive labels press the RESTART key until TRANS. shows in the display. 
❍     If media is plastic press the RESTART key until REFLECT. shows in the display.

●     Press PAUSE until LABEL LEN. shows in the display. 
❍     Press the FEED or RESTART key until the desired size shows in the display.

●     Press the PAUSE key until PAPER FEED shows in the display. 
●     Press the RESTART key until NO PAPER FEED shows. 
●     Press teh PAUSE key until TEST PRINT shows. 
●     Press the PAUSE key until PRINT CONDITION shows in the display. 
●     Press the FEED key until SLANT LINE<3DOT> shows in the display. 
●     Press the PAUSE key and the labels will print the slant line pattern. 

❍     Pressing PAUSE will cancel any errors. 
❍     Pressing PAUSE continuously will reprint the test pattern.
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SX Series Threshold Calibration 

 

SX Series Threshold Calibration

TEC SX-4 and SX-5 series

●     Make sure labels are installed in printer and the gap sensor is in the correct position. 
●     Press the PAUSE key once. 
●     Press and hold the PAUSE key until REFLECTIVE or TRANSMISSIVE appears in the display. 
●     Press the RESTART key to choose the proper sensor type for the material being used. 

❍     REFLECTIVE for plastic labels. 
❍     TRANSMISSIVE for adhesive labels. 

●     Press and hold the PAUSE key for more than 3 seconds and 2 labels have been issued. 
❍     When both conditions have been met, release the PAUSE key. 

●     Press the RESTART key to return to online condition. 
●     Threshold setting is complete. 
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General Procedures 

 

General Procedures

TXP-6 Thermal Printer

To check if the printer has detected the labels: 

●     After completing the calibration, press the feed button once to see if it will feed a single label. 
●     The TXP-6 has an adjustable gap sensor, if you are having trouble detecting the label, please try to adjust the sensor to the 

appropriate position. 

Print Configuration Report: 

●     Turn off the printer. 
●     Press and HOLD the “FEED” button and turn on the power, do not release the button until several labels fed and the 

configuration label has been printed. 
●     The message “SELF TESTING …” will displayed on the LCD. 
●     Reboot printer. 
●     Check and find the firmware version where indicate “PPLA(B) X2A(B)0-X.XX mmddyy”. 
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TXP-6 Media Out 

 

Problems with media

TXP-6 Thermal Printer

Possible Problems: 

Missing Gap: 
●     Check the media path 
●     Check the position of the label sensor 
●     Verify that the media sensor is set correctly for either reflective or see-through. 
Media Out: 
●     Supply the media roll 
Media not installed: 
●     Install the media roll 
Media installed incorrectly: 
●     Make sure the media goes between the media sensor slot and the bottom plate. 
Media Jam: 
●     Recover the Jam 
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Printer Calibration 

 

Printer Calibration

TXP-6 Thermal Printer

Performing Printer Calibration: 

●     Turn off the printer. 
●     Press and HOLD the “PAUSE” button and turn on the power, do not release the button until the labels have begun to feed. 
●     The message “CALIBRATION …” will displayed on the LCD. 
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TXP-6 RAM Clear 

 

RAM Clear

TXP-6 Thermal Printer

RAM Clear: 

●     Turn off the printer. 
●     Press and HOLD the “CANCEL” button and turn on the power, do not release the button until the READY indicator blinks. 
●     The message “E2PROM RESET …” will displayed on the LCD. 
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Complete HASP Uninstall 

 

HASP install keeps crashing computer.

UNINSTALLING ALL REFERENCES TO HASP:

Uninstall HASP Drivers:
●     Go to "Add and Remove Programs" in Control Panel. 
●     Uninstall all HASP references. 
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Complete HASP Uninstall 

 

Go to C:\WINDOWS\system32\drivers
●     Use Aladdin Diagnostix tool to find installed files... 
●     Look for files listed under "Aladdin DRM Drivers." 

DELETE THESE FILES 
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Complete HASP Uninstall 

 

Go to C:\Windows\inf
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Complete HASP Uninstall 

●     Find all files with the prefix "oem" and a suffix of ".inf" (oem*.inf) 
●     Open these files with any text editor. 

●     If the file has Aladdin printed in the file it must be deleted.  

Go to Device Manager:
●     Click "VIEW" then click "Show hidden devices". 
●     Uninstall HASPNT and HARDLOCK located under Non-Plug and Play Drivers. 

Once this is done...
●     Restart the computer. 
●     Download and run the HASP4 GUI installation from Aladdin. 
●     Start the Aladdin Diagnostix tool. 
●     Highlight the HASP entry and click the check key button. 
●     If entry looks similar to picture, installation was a success. 
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Complete HASP Uninstall 

 

Finally:
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Complete HASP Uninstall 

●     Restart the computer. 
●     Restart Taggit Pro. 
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HASP CMD Line installation 

 

Command Line installation of HASP Drivers

●     Download HASP4_driver_cmdline.zip from Aladdin 
●     Unpack or drag hinstall.exe, haspds_windows.dll, and hdinst_windows.dll to desktop. 
●     Close Taggit Pro 
●     Uninstall security key from computer. 
●     Open Device manager. 

❍     Right Click My Computer 
❍     Click on Manage 

●     Click on View 
●     Click on Show Hidden Devices 
●     Open Non-Plug and Play Drivers 
●     Find Hardlock 

❍     Click on Action 
❍     Click on Uninstall 

●     Find Haspnt and highlight. 
❍     Click Action 
❍     Click Properties 
❍     Click Driver tab 
❍     Click on Stop button 
❍     Set startup to disabled 

●     Close Device manager 

●     Open a DOS cmd line 
❍     Click START 
❍     Click RUN 
❍     Type in CMD 

●     Drag and Drop hinstall.exe to DOS cmd. 
●     add space -i -alldrv -kp to cmd line and press enter. 
●     Turn HARDLOCK and HASPNT back to automatic in Device Manager. 
●     Reinstall security key. 
●     Restart computer. 
●     Restart Taggit Pro. 
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Spool File Error 

 

Spool File Error

Taggit Pro

The 1750 Spool File Error occurs when the Windows Print Manager has difficulty communicating with the printer. For whatever 
reason, a stable two-way dialogue cannot be established between the printer and the PC in this instance.  
 
It is a problem with Windows Print Manager. 
Make sure the "Print Spooler" service is running.  
 
To try and eliminate the problem, you can change from using Windows Print Manager to using either Print Station or Direct Printing. 

●     Select Options then Configuration. 
●     Select the Printing Options tab. 
●     Select the Direct Printing or Print Station option. 

 
 
Bypassing the print spooler may solve this problem also. 

●     Open Printers and Faxes from Control Panel 
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Spool File Error 

●     Right-Click on printer and Left-Click on Properties. 
●     Click on the Advanced tab and click "Print directly to the printer" 
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Taggit Pro in Demo Mode 

 

Taggit Pro showing Demo Mode

●     Make sure USB or LPT dongle is inserted in proper port. 

●     If operating system has been upgraded to Windows XP the HASP drivers must be updated. 
❍     Have customer download and install the HASP4 driver.

 
●     If HASP4 does not work properly have customer un-install the HASP4 driver 
●     Have customer download and install the HASP HL driver. 
●     If this does not fix the demo mode problem then have the customer re-install the HASP4 driver. 
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Using Access databases 

 

Connecting TAGGIT Pro to an Access DB

●     Click on Options and then Configuration. 
●     Click on OLE DB Manager tab. 
●     Click on New. 

 
●     Click on Microsoft JET 4.0 OLE DB Provider. 
●     Click next. 
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Using Access databases 

 
●     Browse to Access DB that is going to be used. 
●     Click on Test. 
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Using Access databases 

 
●     If connection is good this box will appear...Click OK. 

 
●     Click OK on Data Link Properties box. 
●     Give the connection a name and click OK. 

 
●     The connection will now show in the connections list and will be available for use on a label. 
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*.XLS to *.DBF 

 

Exporting Excel to TAGGIT PRO Database

●     Open the file. 
●     Starting with Row 1, Column A, click and hold the left mouse button on the first cell. 
●     Drag the mouse downwards and to the right 

❍     The purpose is to highlight the data you want to export. Don’t highlight empty fields. 
●     When finished, release the left mouse button. 
●     Click on format, Select Column, then Autofit Selection. 
●     Click on Format, then Cells. 
●     In the Category box, select Text. Click Ok. 
●     Click on File, then Save As. 
●     At the bottom of the Save As window there is a box called Save as type: 
●     Choose: DBF 4 (dBASE IV) (*dbf) 
●     Type a new file name 8 characters or less with no spaces or punctuations. 
●     Don’t add .dbf or even a period. It will be added automatically. 
●     At the top of the Save As window find the Save in box. 
●     Click the down arrow, and navigate to the TAGGIT PRO DBF directory. 
●     Click Save. Excel will ask you if you want to keep the format etc…. Click No. 
●     The Save As window will open again. Click Cancel. 
●     Close Excel. 
●     Excel will ask you to save changes. 
●     Select NO. 
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TP to Excel via ODBC 

 

Setting up an ODBC connection to Excel with TAGGIT PRO!

         
        Keep in mind that Excel is not a database but a spreadsheet. 
        Any additional items added to the spreadsheet after the ODBC 
        connection has been made will not automatically update the spreadsheet.
        You will have to repeat steps 1 through 5 to update the spreadsheet.

The following steps will tell you how to format your excel spreadsheet and 
create your ODBC connection.

1.  Call up the spreadsheet from within Excel. 
2.  Click on the cell in the upper left corner of the sheet. Hold the shift key and click on the cell in the bottom right of the 

spreadsheet (scroll down and to the right if necessary) to select the entire file. Do not select any empty fields or rows. 
3.  Go to Insert -> Name -> Define. Enter a name for the database and click OK. 
4.  With the cells still highlighted, click on Format -> Cells and choose Text as the category. 
5.  Save the spreadsheet and return to the program to access the new file. 

        These steps are necessary because in Excel - there is no "Table" 
        - so steps 1-3 will create one. Also, since ODBC reads the cell 
        left to right, if the formatting is right justified, it assumes 
        no data is there. Steps 4-5 will left justify all cells.

To create your ODBC connection, with TAGGIT PRO open complete the following steps: 

1.  Go to Options + Directories + ODBC Data Source. 
2.  Choose the Machine Data Source tab. 
3.  If the source you wish to use is already present, proceed to step 5. 
4.  If the source you need is not listed, click New, and proceed with the following steps. 

❍     Choose User Data Source + Next. 
❍     Select the driver for the source file you are using (i.e. Microsoft Access) + Next + Finish. 
❍     Enter a value for Data Source Name. It does not have to be the same as the source file. 
❍     The description field is optional, but it can be useful in identifying different data sources. 
❍     Choose the appropriate button (i.e. Select / Select Workbook) and locate the source file you wish to link too. You may 

need to uncheck the Use Current Directory option, if present, to find your files. 
❍     Click OK to complete the procedure. 

5.  Make sure the data source you need is highlighted in the Select Data Source window. If it is not, click on it once to select. Click 
OK to return to the directories menu. 

6.  You should see the name of the file you created in the ODBC Data Source box. Click OK to return to designing your label. 
7.  Add a field to your label and select ODBC DB as the Data Source. 
8.  Specify the Key field and Print fields as you would when using any database. 

Microsoft is replacing ODBC with OLE DB - however, 
there will be no driver for Excel in OLE DB - your 
best bet would be to convert the Excel spreadsheet 
into an Access database and then use the Microsoft 
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TP to Excel via ODBC 

Jet OLE DB Provider in the OLE DB Manager.
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TP to Excel via OLE DB

 

Connecting to an Excel spreadsheet via OLE DB

1.  Open the MS Excel file you wish to use as a datasource.  
 

  
2.  Highlight the cells you wish to use for the datasource (typically the whole sheet). This can be accomplished by selecting cell 
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TP to Excel via OLE DB

A1 and dragging the pointer to the cell in the opposite corner of the sheet.  
 

  
3.  Once you have the desired data highlighted, choose Insert > Name > Define from the file menu.  

 

  
4.  The Define Name dialog box will open. Type the desired name in the top line and click the OK button.  
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TP to Excel via OLE DB

  
5.  Save your worksheet somewhere you will be able to find easily. You can now close Excel and open Taggit Pro.  

 

  
6.  In Taggit Pro, select Options>Configuration from the file menu.  
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TP to Excel via OLE DB

  
7.  Select the OLE DB Manager tab and click the New button.  
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TP to Excel via OLE DB

  
8.  The Data Link Properties dialog will open. Select the Microsoft Jet 4.0 OLE DB Provider.  

 

  
9.  Switch to the All tab. Select Extended properties and click the Edit Value button.  

 

  
10.  The Edit Property Value dialog will open. On the line that says Property Value, enter Excel 8.0 and click the OK button.  
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TP to Excel via OLE DB

  
11.  Switch to the Connection tab. Click the ellipses button to browse to your Excel file.  
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TP to Excel via OLE DB

  
12.  In order to see Excel files in this browse dialog, you must select All Files for the file type.  

 

  
13.  Select your Excel spreadsheet and click the OK button.  
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TP to Excel via OLE DB

  
14.  Now click the Test Connection button to verify that the new DB connection is working properly.  
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TP to Excel via OLE DB

  
15.  You should receive a confirmation message like the one above, click the OK button and then click the OK button in the Data 

Link Properties dialog.  
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TP to Excel via OLE DB

  
16.  Taggit Pro will ask you to enter a name for your new OLE DB connection. Enter a meaningful name for the data source and 

click the OK button.  
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TP to Excel via OLE DB

17.  You will see your new connection listed on the OLE DB Manager tab. Click the OK button to exit the Configuration dialog.  
 

  
18.  Add a new Text or Barcode field to your label by clicking the appropriate button on the left hand toolbar. You will notice that 

the Database pulldown defaults to a value the same as or similar to the one shown above (using a dollar sign in the name).  
 

  
19.  Using the Database name with the dollar sign will cause errors at print time. Instead select the name you defined for the 

spreadsheet in step 3 for the Database name.  
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TP to Excel via OLE DB

  
20.  Once you have configured all the options for your text or barcode field, click OK and click on the label to drop the new field. 

You will see your field on the label.
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MS Works to TP Database 

 

Converting MS Works database to TAGGIT PRO database

 
●     Q: How do I export my MS Works database to another database program? 
●     A To export a document into a format that Works supports, do the following. 

●     Open the document you want to save. 
●     On the File menu, click Save As. 
●     Click the Save File as Type box and choose a format the other program supports, such as dBASE IV (.dbf) or Text and Tabs. 
●     Click OK. 
●     If you are trying to save a document for use in another database, and that format is not available in the Save As Type box, 

select a format that the other database program can import. For information about the types of formats supported by the 
database program, see the program's user's guide or contact the program manufacturer. 

❍     Microsoft Works 3.0x supports the following database formats: 
■     dBASE III 
■     dBASE IV 
■     Text, comma-separated 
■     Text, tab-separated 
■     Works for Windows, 2.0/Works for MS-DOS 

 
●     Q: What causes the message "Some text has been truncated" when I save a document in dBASE format? 
●     A: This error occurs if the field width for any field in Form view is insufficient. 

❍     To correct this problem, switch to Form, Form view and resize each field so that it is at least as large as its longest 
entry. 

 
●     Q: Why are some fields completely blank after I export my Works database to a dBASE file format? 
●     A: This is usually a result of numeric or date formatting in fields containing text. 

❍     To correct this problem 
■     Select a field that is blank after exporting 
■     On the Format menu, click Number and verify that the field has the correct numeric formatting 
■     Each text field must be formatted as General or Text 
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Print Driver Options and Properties 

 

Printer Driver Options and Settings

●     Open printer and faxes folder. 
●     Highlight desired printer. 
●     Click on File... then Printing Preferences. 

❍     Dialog box should look similar to the pictures below...

 

●     Dimensions should be modified to reflect the size of the stock being used by... 
❍     Creating a new entry. 
❍     Editing the current entry.
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Print Driver Options and Properties 

 

●     Dithering should be set to NONE. 
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Print Driver Options and Properties 

 

●     Print Method should be set to THERMAL TRANSFER. 
●     Sensor should be set to TRANSMISSIVE. 
●     Label gap should be set according to material being used... 

❍     0.00 for plastic tags and notched materials 
❍     0.120 for adhesive labels.
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Print Driver Options and Properties 

 

●     Transfer mode should be set to UNCOMPRESSED 8 BIT (OVERWRITE) 

Click the OK button to close the printing preferences box. 

Back to SG Errors 
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Taggit Pro Configuration 

 

Taggit Pro Configuration Settings

 

 

●     Try different combinations of these checkboxes. 
❍     If Box is checked, uncheck it. 
❍     If Box is un-checked, check it.
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Taggit Pro Configuration 

 

●     Use one or the other of these options... 
❍     If "Direct Printing" is checked, check "Use Windows Print Manager." 
❍     If "Use Windows Print Manager" is checked, check "Direct Printing."

Back to SG Errors 
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